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WEBINAR LOGISTICS

To minimize background
noise, attendees are on
mute

At the end of the

presentation there will be a
Q&A session

If you have a question
during the webinar, you
may put it in the
“Questions’”’ box

A copy of the presentation
and a list of FAQ’s will be
made available after the
webinar
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INTRODUCTIONS

= Bob Smith - Robert.).Smithl @mass.gov
* Highway Safety Division Manager
= Taylor Keown —-Taylor.Keown@mass.gov

* Program Coordinator and primary contact for the
following departments: Abington - Medfield.

= Jennifer Slonina - Jennifer.Slonina@mass.gov

* Program Coordinator and primary contact for the
following departments: Medford - Yarmouth.




AGENDA

Key Dates for Campaigns

Expenditure Report

Activity Reports

Site Visits

Mid-Year/Final Progress Reports

De-Obligation Report
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ELEMENT I:

TRAFFIC SAFETY

® Includes high-visibility enforcement during six (6) campaign periods.

= This element also offers the opportunity to purchase specific equipment to enhance traffic enforcement
efforts. Purchases must be made no later than March 315, 2026.

v" Please notify OGR as soon as possible if there are any concerns with meeting this deadline.

v" If a single-item equipment item exceeds $10,000.00, please confirm with OGR prior to purchasing as some
requests require federal approval by NHTSA.

= FEach department will have (1) traffic enforcement budget for all six (6) campaign periods. This allows for
more flexible spending and the opportunity to focus on campaigns to align with your data/trends as well

as officer shift availability.

Office of Grants and Research
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FFY26 MRS TRAFFIC ENFORCEMENT CAMPAIGNS

=  Enforcement activity should align with the current campaign’s focus. However, it is understood that officers will also
observe and enforce all other traffic safety violations, including seat belt usage.

Traffic Enforcement Campaign Dates

Winter Impaired Driving December I5t-3 15,2025
Distracted Driving April 15t-30t, 2026
Click it or Ticket May [5t-315%,2026
June Speed June 15t-30t", 2026
July Speed July 15t-315t,2026
Summer Impaired Driving August |5t — September 15%, 2026

o
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ELEMENT 2:

PEDESTRIAN & BICYCLIST ENFORCEMENT

Required to conduct overtime enforcement of laws applicable to pedestrian and bicycle safety

Required to utilize internal pedestrian and bicyclist crash data to identify specific strategies, locations,
and times to conduct enforcement

May conduct crosswalk decoy operations that:
v" Involve a plain clothes officer acting as a civilian pedestrian and a uniformed officer making stops

v" Involve a uniformed officer serving as a spotter to relay observed violations to the officer making stops

One (1) enforcement budget for all six (6) Ped & Bike campaign periods. Enforcement periods have
been adjusted based on statewide trends related to pedestrian and bicyclist crash data.

This element also includes any purchases for allowable Pedestrian & Bicyclist Safety ltems

*kPyrchases must be made no later than March 315¢,2026.

Office of Grants and Research &
Highway Safety Division




FFY26 MRS PEDESTRIAN AND BICYCLIST ENFORCEMENT
CAMPAIGNS

Pedestrian and Bicyclist Enforcement Campaign Dates
November [5t-30t, 2025
January [st-315¢,2026
February 1t-28t, 2026
March [5t-315¢, 2026
May [5t-31%%,2026
August |5t — September 15%, 2026

o
Office of Grants and Research la"
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ELEMENT 3:

COMMUNITY AWARENESS, OUTREACH,AND EDUCATIONAL ACTIVITIES

=  Community-based educational activities, officer training, and more

= Changes to an approved activity during the grant period will be considered but must fall within the
reasonable range of activities and must have prior approval by OGR.

v Changes to any activity without OGR’s prior authorization will not be reimbursed.

= Community Awareness and Educational Activities can be done during any month of the grant year
(from the date your contract starts to the date the contract ends).

= [f you have been approved for any travel related expenses, please confirm with your grant
coordinator prior to booking/incurring any costs.

Office of Grants and Research
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MONTHLY EXPENDITURE REPORT TIMELINE

. Community Awareness, .
Calendar Year Month Traffic Ped/Bike TE Equipment |Outreach, and Educational Ped/Bike Report Due
Enforcement Enforcement \ e Safety Items Date
Activities

2025 November Yes Yes Yes 12/15/2025
2025 December Yes Yes Yes 1/15/2026
2026 January Yes Yes Yes 2/15/2026
2026 February Yes Yes Yes 3/15/2026
2026 March Yes 4/15/2026
2026 April Distracted Driving | Yes 5/15/2026
2026 May CIOT Yes 6/15/2026
2026 June Speed Yes 7/15/2026
2026 July Speed Yes 8/15/2026
2026 Aug. 1 - Sept. 15 Summer Impaired Yes 10/1/2026

** Note that the final campaign covers August |t to September 15, and the report due date is October I5t™

Office of Grants and Research
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YOU'VE BEEN
AWARDED MRS
FUNDS, NOW
WHAT!?

O

Review your approved application and budget.
v" What are your measurable objectives for the grant cycle?

v" Progress toward goals and objectives will be required during your Mid- and
Final reporting periods.

Review your town data.

v Where are the biggest opportunities for improvement and how will you
use grant funds to make them?

v" Your efforts should look to address this areas

Equipment and safety items invoices are due to OGR by March 3=,
2026.

v Equipment and Safety Items are meant to support your programming.

v Grant funds do not support equipment-only projects.

Let us assist you with staying on track!

v"If you anticipate any program changes, delays, or other challenges, please
reach out to your assigned program coordinator for assistance.

Office of Grants and Research
Highway Safety Division




MONTHLY
REPORTING

Grant recipients must submit monthly reports to the
Executive Office of Public Safety and Security, Office of
Grants and Research (OGR). The monthly reports cover
activities that occurred or were completed during the
identified reporting period.

Cognito is the reporting platform available online.

Each month you will report any/all activity. Even NO
(ZERO) activity.

Category Options:

Traffic Enforcement OT

Pedestrian and Bike Activity

Child Passenger Safety (CPS) Activity

Community Awareness, Outreach, and Educational Activities

Pedestrian and Bike Safety Items

N NN NN

Traffic Enforcement Equipment


https://urldefense.com/v3/__https:/www.cognitoforms.com/MAOfficeOfGrantsAndResearchOGR/FFY2026MunicipalRoadSafetyMRSMonthlyProgressReport__;!!CPANwP4y!VVDq3XkEMOZnn4tmLRIefR7roqJNC8eUQmxgeetkw4mw9yMnGNuju81JFHftZZ28ExhzULMwg5-1Unl_5km31g$
https://urldefense.com/v3/__https:/www.cognitoforms.com/MAOfficeOfGrantsAndResearchOGR/FFY2026MunicipalRoadSafetyMRSMonthlyProgressReport__;!!CPANwP4y!VVDq3XkEMOZnn4tmLRIefR7roqJNC8eUQmxgeetkw4mw9yMnGNuju81JFHftZZ28ExhzULMwg5-1Unl_5km31g$
https://urldefense.com/v3/__https:/www.cognitoforms.com/MAOfficeOfGrantsAndResearchOGR/FFY2026MunicipalRoadSafetyMRSMonthlyProgressReport__;!!CPANwP4y!VVDq3XkEMOZnn4tmLRIefR7roqJNC8eUQmxgeetkw4mw9yMnGNuju81JFHftZZ28ExhzULMwg5-1Unl_5km31g$
https://urldefense.com/v3/__https:/www.cognitoforms.com/MAOfficeOfGrantsAndResearchOGR/FFY2026MunicipalRoadSafetyMRSMonthlyProgressReport__;!!CPANwP4y!VVDq3XkEMOZnn4tmLRIefR7roqJNC8eUQmxgeetkw4mw9yMnGNuju81JFHftZZ28ExhzULMwg5-1Unl_5km31g$

STARTING YOUR REPORT:

Please complete all sections in this report for each grant-
funded activity.

There is a "Save" feature at the bottom of each page
allowing you to save your responses and provides a unique
link that you may utilize to return and finish the report later
without losing your progress. Once you have completed all
relevant sections in the report, click the "Submit Report”
button.

v" Note: If using this feature more than once, please remember to
“Save” your progress each time.

Once you click “Submit”, you will not be able to edit your
responses. Please refer to the Reporting Schedule on the
previous slide, as the Cognito system will allow you to click
a category that is not open in the month you are reporting.

Reporting Information
Grantee Name *

v
Grantaa Nama iz raquired.

Grantee Contact *

Email Phone *
e

Reporting Period
Reporting Period (Manths) * Reporting Period (¥ear) *

. ~
Fisparting Pariod {Mantha) is rcuired. Raparing Paricd {Yaar) Is mouirad.

Will you be reporting any activity this month? *
OYes O No

Please select the categaries you will be reporting this period. *
[ Traffic Enforcement OT

Pedestrian and Bike Activity

Chikd Passenper Safety (CPS) Activity

G ity Outreach and Actities

Pedestrian Bike Safety tems

Traffic Enforcement Equipment




) New Officer Activity 1

Officer Name * Shift Start Date * shift Start Time * Shift End Date * Shift End Time *

Shift fime should be entered exactly a5 reporfed, if does not need fo be in 15 min increments

Shift Hours

Total Number of:

Traffic Stops * Failure To Stop 89/9 - Citations Failure to Stop 89/9 - Written Warning Speeding - Citations
T . . Speeding - Written Warnings QUI Arrests OUI Drug Arrests Hands-Free Violation 90/13 Citations
raffic Enforcement Activity
Hands-Free Violation 90/13 Written Safety Belt Citations Safety Belt Written Warnings Child Safety Citations
Wamings
Felony/Other Arrests Criminal Summons Fugitives Apprehended Blocked Bicycle Lane Violations
Other Citations Other Written Warnings Verbal Warnings

- Please note that any field marked with an
asterisk (*) will require you to enter a value. + Add New Officer Actvty

Please use this box to provide any information that could help explain stop data during shifts conducted.

Office of Grants and Research
Highway Safety Division




Pedestrian and Bicyclist
Activity

- Please note that any field marked with an
asterisk (*) will require you to enter a value.

() New Officer Activity 1

Officer Name *

Shift Start Date =

Shift Start Time =

Shift End Date *

Shift time should be entered exactly as reporfed, it does not need to be in 15 min increments

Shift Hours

Total Number of:

Motor Vehicle Stops *

Failure to yield to pedestrian in crosswalk -

Citations

Overtaking bicyclist unsafely - Citations

Failure to stop at red light/stop sign -
Written Wamings

Failure to yield to bicyclist - Written
Wamings

Pedestrian Stops *

Bicycle Stops *

+ Add Mew Ped & Bike Activity

Moter Vehicle Citations *

Failure to stop at red light/stop sign -

Citations

Failure to yield to bicyclist - Citations

Speeding - Written Warnings

Other Citations

Pedestrian Citations *

Bicycle Citations *

Motor Vehicle Written Warnings *

Speeding - Citations

Blocked bicycle lane violations

Operating to endanger - Written Warnings

Other Written Warnings

Pedestrian Written Warmnings *

Bicycle Written Warnings *

Office of Grants and Research
Highway Safety Division

Shift End Time *

Motor Vehicle Verbal Warnings *

Operating to endanger - Citations

Failure to yield to pedestrian in crosswalk -
Written Warnings

Overtaking bicyclist unsafely - Written
Warnings

Other Verbal Warnings

Pedestrian Verbal Warnings *

Bicycle Verbal Warnings *




Community Awareness,
Outreach, and
Educational Activities

- Please note that any field marked with an

asterisk (*) will require you to enter a value.

Community Awareness, Outreach and Educational ActivitiesDecember 2025

SRY hous shoukd be Batuwan te () and gt () hours, ayeset wihan an amest s mags duing e ST ang i ot comelated bafore the shY s sehuciian 4 and. The officar may contiua wurking undar ha grant and charpe agdtioos!

hours,

Community Awareness, Outreach and Educational Activities Details
¥ reporting GFE Actvity make sure 4o use tha GFS Acthly fabel IWE is ot on this page, refur io e first Gage and saiect "OFS ACtivly” under the categores being reporfed.

Mame of Activity (i.e. program, reg-
istration fees - please specify) * (Officer/Personnel *

+ Add Activity
Miscellaneaus Uploads

or drag files here.

Invoices, repisiration fees, eir

®

Tatal Hours Worked
0.00

Deseribe/ explain any activity stated above:

If any acsivity is shown above, it must be reflected in the Expenditure report.

¢, Back Mext »

Location *

Date *

Hours Worked *

0.00

Office of Grants and Research
Highway Safety Division




Financial Expenditure Report

An Excel workbook and signed summary sheet must be uploaded even if there is $0 expenditures this month.

What is the amount reported on your Financial Expenditure Report for this month? *

This number can be found on your signed summary page.

Purchase Invoices *

Upload | or drag files here.

If only reporting
Eq u i P m e nt + Safety Ite m S Upload | or drag files here.
a, n d / O r Files must be submitted in xlz, xisx., or xism format

Signed Summary Page

Upload | or drag files here.

Filez must be zubmitted in . pdf format

Budget Excel Workbook *

After entering activity...

The signed summary page attachment is only required if you have not electronically signed the budget workbook.

OGR Assistance

Do you need any training or technical assistance from the Office of Grants and Research? *

Yes No

Office of Grants and Research
Highway Safety Division




FINANCIAL EXPENDITURE REPORT

Financial Expenditure Report

An Excel workbook and signed summary sheet must be uploaded even if there is $0 expenditures this month.

What is the amount reported on your Financial Expenditure Report for this month? * lepartment NamJ Police Department

Total Spend

leporting Period | Mowember 2025

This number can be found on your signed summary page.

Wihat is the amount reported on your Financial Expenditure Report for this month? must be formatied as 58 35 5

Cost Categories Cash Expenditures
Purchase Invoices *
‘raffic Enforcement (TE] Overtime 3 -
Upload | or drag files here.
‘raffic Safety Equipment 5 -
Budget Excel Workbook *
ted & Bike Enforcement Owvertime 5 -

Upload | or drag files here.

‘ommunity Awareness, Dutreach, and

Filez must be submitted in xis, xizx., or .xlzm formsf ducational Activities 3 ]
Signed Summary Page ek These Amounts ted & Bike Safety ltems 5 -
Must Match **
or draq files here.
Total Costs 5 -

Filez must be submittad in . pdf format

The signed summary page attachment is only required if you hawve not electronically signed the budgef workbook.

Fa T ad = T . T



HELPFUL TIPS FOR COMPLETING YOUR ACTIVITY REPORTS

= Provide a printout or electronic version of the activity report to your officers before they conduct
shifts and have them fill it out and return it back to you.

v" Traffic Enforcement Activity Form

v" Pedestrian and Bicyclist Enforcement Activity Form

= Entering shift activity into Cognito as completed. (Utilize the “SAVE” feature so you can go back into
the report to make edits)

= Before submission, double check your report to make sure all shifts listed on the Monthly Expenditure
Report (Excel) correspond to the Activity Reports (Cognito) are the same.

= Be specific on the activities conducted and explain in detail what was completed.


https://massgov-my.sharepoint.com/personal/taylor_keown_mass_gov/Documents/Desktop/Ped.Bike%20Activity%20for%20officers.docx?web=1
https://www.mass.gov/doc/mrs-traffic-enforcement-activity-form-for-officers/download
https://www.mass.gov/doc/mrs-traffic-enforcement-activity-form-for-officers/download
https://www.mass.gov/doc/mrs-pedbike-activity-form-for-officers/download
https://www.mass.gov/doc/mrs-pedbike-activity-form-for-officers/download

MONTHLY EXPENDITURE REPORT

= Every month you will upload your monthly expenditure report
through Cognito, which is then sent to your designated grant
manager.

v" Be sure that this report includes all spending year-to-date (YTD) for
previous months on the YTD tab.

= |f reporting zero expenditures for a given month, a report
submission is required indicating $0 was expended, while
uploading a signed $0 Expenditure Report.

" Most departments have received their authorization email to
begin implementing their programs and are approved to being
spending.

v If you have not received authorization, we are still waiting for the

sighed contract from our Executive Director or waiting for updates
to your department’s contracting documents.

Expenditure Report



https://massgov-my.sharepoint.com/personal/taylor_keown_mass_gov/Documents/Desktop/FY25%20MRS%20Expenditure%20Report_Fringe%20and%20Indirect_10032024.xlsm?web=1

Tips for Completing
Your Expenditure

Report

Before submitting your reports through Cognito each month,
please ensure that it has all the required components completed:

v Budget Summary Sheet (signed and dated)
v Monthly Cash Expenditures Page (YTD breakdown)

v" Activity Line-ltem Subtotal/Total Pages (all).

Double check your monthly cash expenditure page (YTD tab)
each month to ensure that it matches what you have submitted to
us in prior months.

Track and maintain previous months spending on your
expenditure report.

v" It should show all spending that has occurred during the grant
period to date.

v Adhere to your approved budget and do not overspend!

Maintain all records/emails in case you are required to re-submit a
report for any reason.

Office of Grants and Research
Highway Safety Division




= Departments are allowed (and encouraged) to electronically sign the monthly reporting forms

= Within the Excel Financial Reporting Form, and the Ribbon (top row of tabs and icons), click
Draw. If you do not have this tab on your Ribbon, please refer to the instructions found to the left
of this text box.

® - Choose the black pen in the Draw Tools section.

= - After selecting the pen option, the mouse/cursor will turn from an arrow to a black dot. (To
revert to the mouse cursor, simply select that option / icon)

= -You should now be able to sign the Budget Summary page.To complete a signature, use the
draw/pen function to sign your name.

EIeCtron |Ca-| Iy Slgn I ng the Be sure to click back to the mouse when you are done.
Excel Workbook

To add the Draw ribbon in Excel, follow these steps: AutoSave . Oﬁ.\ u v (< Reviewer
1. Launch Excel and click the File tab. u ('_‘)I E)

. Click Options, then select Customize Ribbon.

2 :
3. Enable the Draw tab by checking the Draw tah checkhox. File  Home Insert Drﬁ Page Layout Formul
4

. Click OK to enable the Draw tab on the menu bar ' .Alternatively, you can right- % Pt | | ' I ' . | | .

click the Ribbon, select Customize the Ribbon, check the box next to Draw, and

click OK 2 . gl uER AR U 4
|
Total Costs | | s -
Drawing Toaols
Completed by
Signature: .
| —
Date: Februafy 23, 2023
Print Name: Steven Domings
Email Address: steve.m.domings@mass.gov
Office of Grants and Research
certify that this report, schedules, statements, and the expenses for which payment is H |ghway Safety DiViSion
requested are true, correct, and complete and were made in accordance with the
appropriate Federal and State regulations and that the articles or services listed were




SITEVISITS

®  Throughout the grant period, subrecipients are subject to
compliance monitoring, which includes site visits, where OGR
staff will request grant records to be reviewed.

= |f OGR perceives issues relating to any of the grant
requirements, appropriate action will take place, including, but
not limited to, a site visit, file reviews, non-reimbursement,
and suspension of funding.

®  Subrecipients that do not observe reporting deadlines,
submit incomplete or inaccurate reports, fail to follow the
timeline promised in the grant application, underperform, or

engage in other practices outside of the grant’s limitations
will be at risk of losing OGR grant funding and may become
ineligible to receive future OGR grant funding.




MID-YEAR AND

FINAL PROGRESS
REPORTING

All departments must report on progress toward each measurable
target/goal for both Mid-Year and Final Progress reporting.

v Mid-Year and Final Progress Reports are now integrated into the monthly Cognito
reporting process.

v Progress Reports will be required during April (due May 15%) and the
August/September (due October [*) reporting period.

Please reference your department’s approved goals and objectives
that have been pre-filled in Cognito.

= Note: Goals/objectives that lacked sufficient detail and/or structured were updated
during application review to ensure alignment with program scope and statewide
priority areas.

Please contact OGR regarding questions, concerns, or any proposed
adjustments to the current goals/objectives.

Office of Grants and Research
Highway Safety Division




DE-OBLIGATION REPORT

= A De-obligation Report is due at the end of the grant year along with your final expenditure report.

= The report can be found within one of the tabs at the bottom of your Expenditure Report (Excel) and serves as
confirmation of your department’s expenses throughout the grant year.

v" Note: If there are any discrepancies in the auto-populated totals, please notify your program coordinator as soon as
possible.

= You will sign this form electronically (the same way you sign the monthly summary sheet) or you may print it, sign it,
and upload it with your final monthly report. And upload the excel workbook or scanned report into Cognito.

= |f the de-obligation report is not received within |5 days of submitting your final campaign report, the grant may be
marked final, and you may not have an opportunity to dispute the totals or submit missed reports.

= OGR will send reminder emails out in Fall 2026 regarding the De-Obligation process.

Office of Grants and Research
Highway Safety Division




We would like to thank you all for participating in this VWebinar and for all your future hard work
throughout this grant year of FFY26. Your efforts affect change for road safety in your communities
and for the Commonwealth.

THANK YOUI!




QUESTIONS!?

Taylor.Keown@mass.gov or Jennifer.Slonina@mass.gov

O : For any questions after the webinar please email:

Office of Grants and Research
Highway Safety Division
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